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ne of the fastest growing areas in
institutional investment management is the so-called active extension or 130/30 class of strategies
in which the short-sales constraint of a traditional long-only portfolio is relaxed. Fueled
both by the historical success of long-short
equity hedge funds and the increasing frustration of portfolio managers at the apparent
impact of long-only constraints on performance, 130/30 products have grown to over
$75 billion in assets and could reach $2 trillion
by 2010 (Tabb and Johnson [2007]).
Despite the increasing popularity of such
strategies, considerable confusion still exists
among managers and investors regarding the
appropriate risks and expected returns of
130/30 products. For example, the typical
130/30 portfolio has a leverage ratio of 1.6 to
1, unlike a long-only portfolio that does not
use leverage. Although leverage is typically associated with higher volatility returns, the
volatility and market beta of a typical 130/30
portfolio are comparable to those of its longonly counterpart. Nevertheless, the added
leverage of a 130/30 product suggests that the
expected return should be higher than its longonly counterpart, but by how much? By deﬁnition, a 130/30 portfolio holds 130% of its
capital in long positions and 30% in short positions. Thus, the 130/30 portfolio may be viewed
as a long-only portfolio plus a market-neutral
portfolio with long and short exposures that
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are 30% of the long-only portfolio’s market
value. The active portion of a 130/30 strategy,
however, is typically very different from a marketneutral portfolio so that this decomposition is,
in fact, inappropriate.
These unique characteristics suggest that
existing indexes such as the S&P 500 and the
Russell 1000 are inappropriate benchmarks
for leveraged dynamic portfolios such as
130/30 funds. A new benchmark is needed,
one that incorporates the same leverage constraints and portfolio construction algorithms
as 130/30 funds, but is otherwise transparent,
investable, and passive. We provide such a
benchmark in this article.
Using ten well-known and commercially available valuation factors from the
Credit Suisse Quantitative Equity Research
Group from January 1996 to September 2007,
we construct a generic 130/30 U.S. equity
portfolio using the S&P 500 universe of stocks
and a standard portfolio optimizer. The historical simulation of this simple 130/30
strategy—rebalanced on a monthly basis—
yields a benchmark time series of returns that
can be viewed as a 130/30 index. By using
only information available prior to each rebalancing date to formulate the portfolio
weights, we create a truly investable index.
And by providing both the data and the algorithm for computing the portfolio weights, we
render the index passive and transparent.
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Of course, our proposal of an algorithm, or dynamic
portfolio, as an index is a signiﬁcant departure from the
norm. Existing indexes such as the S&P 500 are deﬁned
as baskets of securities that change only occasionally, not
dynamic trading strategies requiring monthly rebalancing.
Indeed, the very idea of monthly rebalancing seems at
odds with the passive buy-and-hold ethos of indexation.
The introduction of short sales and leverage into the
investment process, however, poses challenges for any
buy-and-hold benchmark. Moreover, as the market
demand for more sophisticated benchmarks grows, and
as trading technology becomes more powerful and
increasingly automated, the need for more dynamic
indexes—indexes capable of capturing time-varying characteristics—will arise.
One example of the market’s growing sophistication is the advent of life-cycle mutual funds. Life-cycle
funds target a specific cohort of investors who plan to
retire at some ﬁxed date in the future. These funds change
their asset allocation over time as each cohort’s retirement
year draws nearer. In this article, we argue that a dynamic
strategy can also be passive if the rebalancing algorithm
is sufﬁciently mechanical and easily implementable. For

dynamic strategies such as these, indexes can also be developed, and our 130/30 index is just one example.
A literature review of long-short equity investing
indicates that the analytics of 130/30 strategies have only
recently been formally developed. These analytics provide the motivation for a 130/30 index. In comparison
to groups of heterogeneous 130/30 managers, this index
more directly captures the aggregate performance of
active-extension strategies. We acknowledge that our proposal of using a strategy as an index is rather unorthodox,
so in the third section of the article we provide some historical perspective for this break from tradition. We then
present the basic framework for constructing a generic
130/30 strategy as well as a summary of the strategy’s
empirical properties, before offering our concluding
remarks.
LITERATURE REVIEW

Although 130/30 strategies are relatively new, the
literature on long-short equity strategies is well developed. Grinold and Kahn [2000] and Ineichen [2002]
provide a useful chronology of this literature. Proponents
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of long-short investing argue that because the vast
majority of market action has occurred on the long side,
the inefﬁciencies on the short side of the spectrum have
not yet been eliminated. For example, Jacobs and Levy
[1993b] and Miller [2001] suggest that overvaluation is
more common and of greater magnitude than undervaluation and thus increases the appeal of the short side to
alpha hunters. This tendency toward overvaluation can
be attributed to the underweighting constraint of longonly portfolios, the limited amount of short selling in the
market, and the tendency of brokers to favor buy recommendations. Michaud [1993] counters this argument
by suggesting that long-only active portfolio managers
can also exploit short-side information by underweighting
securities in the benchmark, while Arnott and Leinweber
[1994] and Jacobs and Levy [1995b, 2007a] emphasize
the constraints on underweighting stocks in long-only
portfolios.
Advocates of long-short portfolios also point to the
diversification benefits provided by the short side.
According to them, a long-short strategy includes a long
and a short portfolio; if the two portfolios are uncorrelated,
the combined strategy would have a higher information
ratio than the two separate portfolios as a result of diversiﬁcation. This point is summarized by Grinold and Kahn
[2000] who explain that it cannot be used as a justiﬁcation for long-short investing since it also applies to the
active portion of long-only portfolios. Jacobs and Levy
[1995a] address the diversiﬁcation argument by observing
that long and short alphas are not separately measurable in
an integrated long-short optimization framework. They
suggest that the correlation between the separate long and
short portfolios is not relevant. A theoretical framework
and algorithms for integrated optimization with short
selling are developed by Jacobs, Levy, and Markowitz
[2005, 2006].
Michaud [1993] is among the ﬁrst to argue that costs
related to short sales are an impediment to efﬁciency. The
practical relevance of such costs has been debated by Arnott
and Leinweber [1994], Michaud [1994], and Grinold and
Kahn [2000]. Jacobs and Levy [1995b] suggest that these
costs are not higher than those of long-only investing and
that, in fact, the fees per active dollar managed may be
much higher in the long-only case.
More recently, the center stage of the long-short
debate has focused on whether efﬁciency gains result from
relaxing the long-only constraint. For example, Brush
[1997] shows that adding a long-short strategy to a long
14
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strategy expands the mean-variance efﬁcient frontier, provided that long-short strategies have positive expected
alphas. Grinold and Kahn [2000] show that information
ratios decline when one moves from a long-short to a
long-only strategy. They stop short of deriving an analytical expression for the loss in efﬁciency which results
from the long-only constraint, and use a computer simulation to estimate the magnitude of the impact. Jacobs,
Levy, and Starer [1998, 1999] further elaborate on the
loss in efﬁciency that can occur as a result of the long-only
constraint. And Martielli [2005] illustrates empirically
how removing the long-only constraint improves the
expected information ratio for U.S. large-cap equity funds,
even after accounting for the additional costs associated
with shorting stocks.
Clarke, de Silva, and Thorley [2002] develop a framework to measure the impact of constraints on the value
added by and the performance analysis of constrained portfolios. They provide a generalized version of Grinold’s
[1989] fundamental law of active management which
relates the expected performance of managers and the
information coefﬁcient of their forecasting processes, recognizing that various implementation constraints prohibit
managers from fully exploiting their ability to forecast
returns. To capture the impact of these constraints they
introduce a transfer coefﬁcient into the fundamental law
as a measure of how effectively manager information is
transferred into portfolio weights. Clarke, de Silva, and
Thorley [2002] use this framework to provide further support for long-short strategies by showing that the transfer
coefﬁcient falls more by imposition of the long-only constraint than by imposition of any other single restriction.
Clarke, de Silva, and Sapra [2004] empirically gauge the
impact of various constraints and conclude that the longonly constraint is often the most signiﬁcant in terms of
information loss. They show that lifting this constraint is
critical for improving the information transferred from
stock-selection models to active portfolio weights.
Sorensen, Hua, and Qian [2007] use numerical simulations of long-short portfolios to demonstrate the net beneﬁts of shorting and to compute the optimal degree of
shorting as a function of alpha, desired tracking error,
turnover, leverage, and trading costs. Johnson, Kahn, and
Petrich [2007] further emphasize the loss in efficiency
from the long-only constraint as well as the importance
of the concerted selection of gearing and risk in the execution of long-short portfolios.
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With champions of long-short investing increasingly outnumbering its adversaries, the need for a formal
model to analyze the factors that determine the size of the
short extension in long-short portfolios has become more
pressing. Clarke, de Silva, Sapra, and Thorley [2007] have
ﬁlled this gap. Adopting several simplifying assumptions
regarding the security covariance matrix and the concentration proﬁle of the benchmark, they derive an equation that shows how the expected short weight for a
security depends on the relative size of the security’s
benchmark weight and its assigned active weight in the
absence of constraints. They argue that to maintain a constant level of active risk, the long-short ratio should be
allowed to vary over time to accommodate changes in
individual security risk, security correlation, and benchmark weight concentration.
Finally, Martielli [2005] and Jacobs and Levy [2006]
provide an excellent practical perspective on the mechanics
of enhanced active equity portfolio construction and a
number of operational considerations. The advantages of
enhanced active equity over equitized long-short strategies are summarized in Jacobs and Levy [2007b].

CAN A STRATEGY BE AN INDEX?

In this section, we illustrate the substantial intellectual history that motivates this article. We depart from
standard terminology in one important respect: We are
proposing a strategy as a passive benchmark for 130/30
products, rather than a static, or buy-and-hold, basket of
securities. This departure deserves further discussion and
elaboration.
A common reaction to the use of a strategy as an
index is to cry foul. How can an active portfolio be used
as a benchmark for other active portfolios, particularly if
the very purpose of a benchmark is to gauge the valueadded by active management? Is it not unfairly raising the
bar for active managers by including alpha in the benchmark? If an active strategy is used as an index, how is one
particular active strategy chosen over another? By what
set of criteria do we select or construct a “strategy index”?
To address these legitimate objections, we need to revisit
the deﬁnition and purpose of a market index, and then
explore the possibility that a strategy can satisfy that definition and purpose better than a static portfolio.
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The notion of a “normal” portfolio, ﬁrst proposed
by Barr Rosenberg and implemented by BARRA in the
1980s (see, e.g., Kritzman [1987], Divecha and Grinold
[1989], and Christopherson [1998]), was an attempt to
construct customized indexes for specialized managers in
order to provide insight into their unique risk exposures.
Christopherson [1998, p. 128] offers the following definition of a normal portfolio:
A normal portfolio is a set of securities that contains all of the securities from which a manager
normally chooses, weighted as the manager would
weight them in a portfolio. As such, a normal portfolio is a specialized index.

This definition seems intuitive, but it is vague
regarding whether the normal portfolio is dynamic or
static; the term “index” suggests a static nature, while the
phrase “weighted as the manager would weight them”
suggests a dynamic nature. Christopherson [1998, p. 128]
writes further that

never be rebalanced because the weights automatically
and proportionally adjust as market valuations ﬂuctuate.
These buy-and-hold portfolios are attractive not only
because they minimize trading costs, but because they are
simple to implement from an operational perspective. It
is easy to forget the formidable challenges posed by the
back-ofﬁce, accounting, and trade reconciliation processes
for even moderate-sized portfolios in the days before personal computers, FIX engines, and electronic trading platforms. A vivid reminder of these early challenges is
provided by Bogle [1997] through a fascinating account
of the origins of the very ﬁrst index mutual fund—the
Vanguard Index Trust. In the following passage, Bogle
describes the intellectual roots of the mutual fund business:

[t]he object of using a normal portfolio as a benchmark is to improve one’s understanding of a manager’s investment activities. This is accomplished
by comparing the manager’s performance against
a passive investment alternative (such as a portfolio
of securities from which the manager actually
selects) that approximately matches the manager’s
investment activity.

The basic ideas go back a few years earlier. In
1969–1971, Wells Fargo Bank had worked from academic models to develop the principles and techniques leading to index investing. John A. McQuown
and William L. Fouse pioneered the effort, which led
to the construction of a $6 million index account
for the pension fund of Samsonite Corporation. With
a strategy based on an equal-weighted index of New
York Stock Exchange equities, its execution was
described as “a nightmare.” The strategy was abandoned in 1976, replaced with a market-weighted
strategy using the Standard & Poor’s 500 Composite
Stock Price Index. The first such models were
accounts run by Wells Fargo for its own pension
fund and for Illinois Bell.

Christopherson thus appears to adopt a “passive”
interpretation, yet requires that the passive portfolio proxy
the manager’s investment activity. This seemingly contradictory set of characteristics can only be resolved by
acknowledging the possibility of a passive benchmark that
is also dynamic.
The academic finance literature is replete with
studies that employ portfolios with changing weights in
order to investigate certain anomalies.1 From the practitioner’s perspective, however, a portfolio that has changing
weights is inconsistent with the traditional deﬁnition of
an index which is a value-weighted basket of a ﬁxed set
of securities, such as the S&P 500. The original motivation behind ﬁxing and value-weighting a set of securities
was to reduce the amount of trading needed to replicate
the index in a cash portfolio. Apart from additions and
deletions to the index, a value-weighted portfolio need

The fact that constructing cash portfolios of broadbased indexes was extremely difﬁcult and costly in the
1970s and 1980s is now a distant memory to the technology-savvy managers of today’s multi-trillion-dollar
index-fund industry. An enduring legacy of that era is the
static value-weighted benchmark, which persists today
due to its inherent economy of implementation as well
as to cultural inertia. Similar to the recent advances in
trading technology which have indelibly altered the practice of portfolio management, the concepts of benchmarks, indexes, and passive investing are also evolving as
rapid technological advances sweep the ﬁnancial markets.
One approach to understanding the nature of this
evolution is to adopt the functional perspective of Merton
[1989, 1995a,b] and Merton and Bodie [2005]. What
functions does an index serve? Is it possible that such functions may be better served by an approach other than static
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value-weighted portfolios? We can identify at least two
distinct functions of an index: (1) a passive benchmark
against which active managers can be compared and (2) a
transparent, investable, and passive portfolio that has a riskreward proﬁle which appeals to a broad range of investors.
A key concept of both index functions is that they
are passive, a trait most investors and managers equate
with static low-cost buy-and-hold portfolios. However,
a functional deﬁnition of passive can be more general: An
investment process is deemed passive if it does not require
any discretionary human intervention. In the 1970s, this
notion of passive investing would have implied a static
value-weighted portfolio. But the meaning of passive
investing has changed with the many technological innovations that have transformed the ﬁnancial landscape over
the last three decades—for example, automated trading
platforms, electronic communications networks, computerized back-ofﬁce and accounting systems, and straightthrough processing.
One recent example is the fundamental index of
Arnott, Hsu, and Moore [2005]. A fundamental index
is not value-weighted, does not rely on human intervention, and is purely rule-based. Another example is

the proliferation of automated trading algorithms provided by many brokerage ﬁrms which allow institutional
investors to trade entire portfolios of securities with a
single mouse-click to achieve the volume-weightedaverage-price or time-weighted-average-price benchmark for their portfolios. But perhaps the most
compelling illustration of the changing nature of benchmarks and indexes is the proliferation of life-cycle funds
which are designed for speciﬁc cohorts of investors sorted
by their planned retirement dates. For example, the
investment policy of the Vanguard Target Retirement
2015 Fund (VTXVX) is summarized by the following
passage (www.vanguard.com):
The fund invests in Vanguard mutual funds using
an asset allocation strategy designed for investors
planning to retire between 2013 and 2017. The
fund’s asset allocation will become more conservative over time. Within seven years after 2015, the
fund’s asset allocation should resemble that of the
Target Retirement Income Fund. The underlying
funds are: Vanguard Total Bond Market Index
Fund, Vanguard Total Stock Market Index Fund,
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Vanguard European Stock Index Fund, Vanguard
Paciﬁc Stock Index Fund, and Vanguard Emerging
Markets Stock Index Fund.

Life-cycle funds are not static, but neither are they
actively managed. One of the beneﬁts of technology is the
ability to create passive portfolios capable of capturing
more complex risk-return proﬁles, such as those of an
aging population preparing for retirement.
In this article, we propose a passive index that
involves a mechanical investment process and leads to a
plain-vanilla 130/30 portfolio. The concept of a strategy
as an index is far more general, however, and we believe
a broad array of such indexes would provide useful information for investors. Indeed, the burgeoning literature
and industry applications involving hedge-fund beta replication is just one manifestation of this trend toward transparency through mechanical portfolio construction rules
(e.g., Hasanhodzic and Lo [2007]). We expect more
dynamic strategies to become passive benchmarks as the
investor base becomes more sophisticated and demanding.
INDEX CONSTRUCTION

A 130/30 strategy has two basic components: forecasts of expected returns, or alphas, for each stock in the
portfolio universe, and an estimate of the covariance
matrix used to construct an efﬁcient portfolio. In this section we describe a set of ten composite alpha factors developed by the Credit Suisse Quantitative Equity Research
Group and distributed regularly to its clients. The factors
cover a broad spectrum of valuation models ranging from
investment style to technical indicators. We use a simple
equal-weighted average of these ten factors as our generic
expected-return forecast. The covariance matrix used to
construct a mean-variance efﬁcient portfolio is given by
the Barra U.S. Equity Long-Term Risk Model.
In this section, we also describe the parameter settings used to determine the portfolio weights of our
130/30 index, and we show how to compute an upper
bound on the performance of a 130/30 portfolio by constructing a look-ahead index. In the portfolio optimization process, a look-ahead index uses the realized monthly
returns of each security instead of forecasted returns.
Although achieving such returns is impossible because no
one has perfect foresight, this upper bound serves as a
yardstick for measuring the economic signiﬁcance of the
alpha captured by a particular portfolio.
18
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Expected Excess Return Forecasts

The alpha forecasts used in the construction of our
130/30 index (CS 130/30 Investable Index) are obtained
from the Credit Suisse Quantitative Equity Research
Group and consist of ten distinct composite factors. These
can be categorized into ﬁve broad investment areas: value,
growth, profitability, momentum, and technical. Each
strategy was developed using fundamental data from ﬁnancial statements, consensus earnings forecasts, and marketpricing and volume data. These factors can be used as
stand-alone investment strategies (e.g., investors can simply
create portfolios of stocks with varying exposure to the
alpha factors). The alpha factors can also be used as a
bellwether for certain market trends and cycles. For
example, if value factors are outperforming in the S&P
500, investors may take this as a signal that a shift to value
is underway.2
We now describe each of the ten alpha factors and
list the ﬁnancial indicators used in their computation. The
methodology for combining these indicators to obtain
the composite factors is described later in this section.3
1. Traditional Value. The traditional-value alpha portfolio buys cheap stocks and shorts expensive stocks.
We construct the traditional-value factor using price
ratios such as price to earnings, price to book, price
to cash flow, and price to sales. We refer to this
approach as traditional value because these ratios
have long served as the traditional measures of value.
2. Relative Value. For relative-value alpha, we measure
value using such industry-relative price ratios such
as price to earnings, price to book, and price to
sales. For example, the industry-relative price-toearnings ratio of company XYZ is constructed by
taking the XYZ price-to-earnings ratio and standardizing it using the median and standard deviation
(computed using the median) of that ratio across all
companies in XYZ’s industry group. In this
approach, a stock is considered cheap if its ratio is
less than the industry average. We also look at the
same measure across time by standardizing the
industry-relative ratio of each company with its historical ﬁve-year average and standard deviation. We
consider a stock cheap if the current spread between
its ratio and the industry average is less than the historical ﬁve-year average spread.
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3. Historical Growth. The historical-growth alpha portfolio buys stocks with strong records of growth and
shorts stocks with ﬂat or negative growth rates. We
measure growth based on earnings growth rates,
revenue trends, and changes in cash ﬂows.
4. Expected Growth. The expected-growth alpha portfolio buys stocks with high rates of expected earnings
growth and shorts those with low or negative
expected growth rates.
5. Profit Trends. The proﬁt-trends alpha portfolio buys
stocks showing strong bottom-line improvement
and shorts stocks showing deteriorating proﬁts or
increasing losses. We measure proﬁt trends using the
following ratios: overhead to sales, earnings to sales,
and sales to assets. We also use trends in the following ratios: receivables plus inventories to sales,
cash ﬂow to sales, and overhead to sales.
6. Accelerating Sales. The accelerating-sales alpha portfolio buys stocks with strong records of sales growth
and shorts stocks with ﬂat or negative sales growth.
7. Earnings Momentum. We deﬁne earnings momentum
in terms of earnings estimates, not historical earnings. The earnings-momentum alpha portfolio buys
stocks with positive earnings surprises and upward
estimate revisions, and shorts stocks with negative
earnings surprises and downward estimate revisions.
8. Price Momentum. The price-momentum alpha portfolio buys stocks with high returns over the past 6
to 12 months and shorts stocks with low or negative returns over the past 6 to 12 months.
9. Price Reversal. Price reversal is the pattern in which
short-term winners suffer a price downturn and
short-term losers enjoy a price upturn. These
reversal patterns are evident for horizons ranging
from one day to four weeks.
10. Small Size. The small-size alpha portfolio buys the
smallest decile stocks in the index and shorts the
largest decile stocks in the index. We measure size
using the following metrics: market capitalization,
assets, sales, and stock price.
Stocks with high exposure to the ten alpha factors
are forecast to provide positive alpha and stocks with low
exposure to the factors are expected to generate negative
alpha. Therefore, we invert all the traditional-value and
relative-value ratios, with the exception of the dividend
yield, so that a high number indicates positive alpha. For
the same reason, all of the price-reversal and small-size

WINTER 2008

individual alpha measurements, as well as two proﬁt-trends
individual alpha measurements—1) Industry-Relative
Trailing 12-Month Receivables and Inventories to Trailing
12-Month Sales and 2) Trailing 12-Month Overhead to
Trailing 12-Month Sales—are multiplied by –1.
As just described, each company in the S&P 1500
universe has ten composite alpha-factor time series
associated with it, each of which consists of the factor’s
constituent alpha measurements. For example, the traditional-value composite alpha factor is composed of
the following five constituent factors: price to book
value (P/BV), dividend yield, price to trailing cash ﬂow,
price to trailing sales, and price to forward earnings.
We now describe the algorithm used to combine these
individual alpha measurements into composite alphafactor z-scores. After, say, the P/BV ratio is computed
for a particular company on a particular date, the following two-step normalization procedure is used to
compute its z-score (beginning with a sample of all
companies in the S&P 1500):
1. The P/BV z-score is computed by normalizing the
ratio using the ratio’s cap-weighted mean across the
S&P 500 companies and its standard deviation across
the S&P 1500 companies. The standard deviation
is computed using the cap-weighted mean, but the
squared deviations from the mean are not capweighted.
2. The companies with z-scores computed in Step 1
that are greater than 10 in absolute value are dropped
from the sample, and the cap-weighted S&P 500
mean and the S&P 1500 standard deviation are recomputed based on this smaller sample. Then, the
P/BV of each company (from the original sample)
is re-normalized.
Using the same methodology, we compute the
z-scores of each of the following ratios: dividend yield,
price to trailing cash ﬂow, price to trailing sales, and price
to forward earnings. To compute the traditional-value
composite alpha-factor z-score, we ﬁrst take an equalweighted average of the z-scores of the factor’s ﬁve constituents. Any constituent z-score that is greater than 10
or less than –10 is set to 10 or –10, respectively. We then
normalize that equal-weighted average in two steps as
previously described.
The composite alpha-factor z-scores for each of
the other nine composite alpha factors are obtained in
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the same way given the factor’s corresponding constituent indicators. Then, for each company in the S&P
500 and for each date, we compute the equal-weighted
average of its corresponding ten composite alpha-factor
z-scores, and use this score as the excess-return input
in the portfolio optimizer as described in the following
subsection.
Portfolio Construction Algorithm

We use the MSCI Barra Aegis Portfolio Manager
with the Barra U.S. Equity Long-Term Risk Model to
construct the 130/30 investable and look-ahead portfolios on a monthly basis for the period January 1996
to September 2007. For each month, we use the S&P
500 as the benchmark and the universe to construct the
portfolios. We start with $100 million in cash and rebalance on a monthly basis (i.e., for each month after January 1996, we input the previous month’s portfolio as
the initial portfolio in the optimization process). The
following speciﬁcations are used (see the appendix for
further details):
Constraints: We constrain the portfolio beta to equal
one.
Expected returns: For each company in the S&P 500
and for each date, we use the equal-weighted average of
the company’s corresponding ten composite alpha-factor
z-scores as the excess-return input in the optimizer when
constructing the investable portfolio, and we use the onemonth forward excess return when constructing the lookahead portfolio. We set the risk-free rate, the benchmark
risk premium, and the expected benchmark surprise all
to zero.
Optimization type: We use long-short portfolio
optimization for which we set the long- and short-position leverage to 130% and 30%, respectively.
Trading: We do not put any constraints on the
holding and trading threshold levels, and we set the active
weight to 40 bps. This yields a tracking error, deﬁned as
the annualized standard deviation of the difference
between the portfolio and the benchmark daily return
series, between 1.5% and 3% for each month.
Risk: We use the Barra default setting, which
includes the following speciﬁcations: mean return of zero,
probability level of 5%, risk aversion value of 0.0075, and
AS-CF risk aversion ratio of 1.
Transaction costs: We set one-way transaction costs
to 0.25% and construct portfolios with three levels of
20
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annualized turnover—15%, 100%, and unconstrained—
which are intended to span the relevant range of interest
for most investors and managers.4 We also impose a shortsales cost that reﬂects the spread between the short rebate
and the borrowing cost of leverage, which we assume to
be 0.75% annually (e.g., Martielli [2005]).5 Therefore, we
deduct 30% × 0.75%/12 from the monthly returns of our
130/30 portfolio.
Tax costs: We do not assume any model for the
tax costs.
Under these parameters, the portfolio optimization
process generates for each month the optimal number of
shares to be held for each stock in our 130/30 portfolio.
Now, for each stock i in our portfolio, we have the following monthly information: the number of shares Sit–1 at
the end of the previous month, the price per share Pit–1 at
the end of the previous month, and the total return for
month Rit. We use this information to form the net-of-cost
monthly 130/30 portfolio total return Rpt, as follows:
R pt

≡

n

∑Σ
i =1

P S
P S

it −1 it −1
n
j =1 jt –1 jt –1

Rit – TCostt t – SCost t

TCost t ≡ 0.0025 × 2 × 1.6 × Turnovert
SCost t ≡ 0.3 × 0.0075/12

(1)

where TCostt is the direct transaction costs incurred in
month t, Turnovert is the monthly turnover as calculated
by the MSCI Barra Aegis Portfolio Manager, and SCostt
is the cost associated with the short side of the 130/30
portfolio (i.e., the spread between the short rebate and
the borrowing cost due to the use of leverage).6
The Look-Ahead Index

We create a look-ahead index at month-end using
exactly the same portfolio construction process as for
the investable index, but we replace the expected excessreturn forecast with the realized excess return for that
month. Instead of creating a z-score as the proxy for the
expected excess return, for each stock we simply use the
difference between the one-month forward return of the
stock and the S&P 500 index as the expected excessreturn input for the MSCI Barra Aegis Portfolio Manager. A portfolio created in this manner obviously has
“perfect foresight” because it uses realized returns rather
than expected-return forecasts; returns for this portfolio
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will serve as an upper limit to total available alpha.
Because this portfolio is created with the same constraints as the investable index, the return for the portfolio will be the maximum potential return available for
the 130/30 strategy. Investors and portfolio managers
can use this return to gauge the amount of alpha captured by their own portfolios, which can be a useful
measure of alpha decay over time.
EMPIRICAL RESULTS

Using the procedure outlined in the previous section
and using data for the period from January 1996 to September 2007, we construct the returns of our 130/30
strategy assuming a one-way transaction cost of 0.25% and
an annual short-sales cost of 0.75%, using three levels of
annual turnover—15%, 100%, and unconstrained. Given
that our universe is the S&P 500, a one-way transaction
cost of 0.25% may overestimate transactions costs for most
130/30 portfolios. Transaction costs tend to be higher,
however, for portfolios constructed purely from fundamental or discretionary considerations. Hence, we use a
more conservative value to accommodate for these as well
as the more typical quantitative 130/30 portfolios. Since
the S&P 500 has an annual turnover of roughly 2% to 10%
(see Exhibit 8), a turnover level of 15% preserves the passive nature of our 130/30 portfolio while allowing it to
respond each month to changes in the underlying alpha
factors. Therefore, most of our analysis will center on this
case. The next two subsections summarize the basic performance characteristics of the 130/30 index and provide
the trading statistics for the 130/30 portfolio, respectively.
Historical Risk and Return

Exhibit 1 summarizes the performance of the
130/30 index with 0.25% one-way transaction costs and
0.75% annual short-sales costs, and three levels of annualized turnover constraints—15%, 100%, and unconstrained. For comparison, we also include summary
statistics for the 15% turnover case without deducting any
transaction or short-sales costs, as well as the look-ahead
portfolio and the S&P 500 index. The average return of
the 130/30 index is 14.08% with no turnover constraints.
The average return becomes 14.25% and 11.76% with
turnover constraints of 100% and 15%, respectively. The
difference in performance between the unconstrained and
highly constrained portfolios is not surprising, given the
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differences in the amount of trading required for their
implementation; the unconstrained portfolio generates
approximately 350% turnover per year compared to 15%
turnover in the constrained case (see the next subsection
and Exhibits 6 and 7). Given the high transaction costs
of 0.25%, it is reasonable that the somewhat constrained
case of 100% turnover performs better than the unconstrained case, since the latter does not incorporate transaction costs in the optimization process.
Transaction costs have little impact on the volatility
of the 130/30 index, which is approximately 15% for the
investable index under all three levels of turnover and is
similar to the 14.68% standard deviation of the S&P 500.
This volatility level implies a Sharpe ratio of 0.44 for the
130/30 index with 0.25% one-way transaction costs, 0.75%
annual short-sales costs, and a 15% annualized turnover
constraint, assuming a 5% risk-free rate. This compares
favorably with the Sharpe ratio of 0.37 for the S&P 500.
Of course, some have argued that such a comparison is
inappropriate because the 130/30 strategy is leveraged; this
argument is the very motivation for our index. By controlling the volatility and beta of our 130/30 strategy, we
hope to create a benchmark that is as closely comparable
to the S&P 500 as possible, while allowing the unique characteristics of long-short equity investing to emerge.
Exhibit 2 plots the cumulative returns of the CS
130/30 Investable Index (with 0.25% one-way transaction
costs, 0.75% annual short-sales costs, and 15% and 100%
annualized turnover constraints) and other popular indexes
such as the S&P 500, Russell 2000, and CS/Tremont
Hedge Fund Index. These plots show that the 130/30
index behaves more like traditional equity indexes than the
CS/Tremont Hedge Fund Index, but does exhibit some
performance gains over the S&P 500 and Russell 2000.
These performance gains are more readily captured
by Exhibit 3, in which the geometrically compounded
annual returns of the 130/30 strategy with 0.25% one-way
transaction costs, 0.75% annual short-sales costs, and a 15%
annualized turnover constraint are plotted, as well as the
strategy's long-side and short-side returns and the comparable S&P 500 returns, where the long-side (short-side)
returns are defined as the returns of the strategy's long
(short) positions. With the exception of 2002, Exhibit 3
shows that the short positions of the 130/30 portfolio hurt
performance; hence it is tempting to conclude that the
short side adds little value. However, this interpretation
ignores the diversiﬁcation beneﬁts that the short positions
yield, as well as the ﬂexibility to take more active risk on
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EXHIBIT 1
Summary Statistics for the Monthly Returns of the CS 130/30 Investable and Look-Ahead Indexes and the
S&P 500 Index, January 1996 to September 2007

*A risk-free rate of 5% is assumed.
†NC = No Constraint.
Note: The annualized mean returns are arithmetic averages of monthly returns multiplied by 12, not compounded geometric averages.

the long side while maintaining a unit beta and a 100%
dollar exposure for the portfolio.
A year-by-year comparison of the 130/30 strategy
with the S&P 500 suggests that the increased ﬂexibility of
the 130/30 portfolio does seem to yield beneﬁts over and
above the S&P 500. However, there are periods such as
1998, 2002, and 2006 where the 130/30 strategy can
underperform the S&P 500. Exhibit 4 contains the monthly
and annual returns of the various 130/30 investable and
22
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look-ahead indexes and the S&P 500 index, and a direct
comparison shows that the annualized tracking error of
the 130/30 index with 0.25% one-way transaction costs,
0.75% annual short-sales costs, and a 15% annualized
turnover constraint is 1.83% and the average excess return
associated with this 130/30 index 1.26%, implying an
information ratio (IR) of 0.69.7 However, given the passive and transparent nature of the 130/30 strategy we have
proposed, this impressive IR should not be interpreted as
WINTER 2008
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EXHIBIT 2
Comparison of the Cumulative Returns of the CS 130/30 Investable Index and Other Indexes,
January 1996 to September 2007

a sign of “alpha,”8 but rather as the beneﬁts of increased
ﬂexibility provided by the 130/30 format.
It is well-known that a long-only portfolio with
no alpha will not beneﬁt from the ﬂexibility of leverage
and short sales. Consider the trivial example of leveraging all the positions of the S&P 500 by an additional
30%, and then shorting every stock by 30%. The outcome of this 130/30 portfolio is simply the S&P 500. For
a 130/30 portfolio to yield positive excess return above
and beyond its long-only counterpart, the factors used
to construct expected-return forecasts must add value.
In the appendix subsection A.3, we report the performance summary statistics of the long-only version of the
130/30 investable index. Exhibit A2 shows that the CS
factors do add value above and beyond the S&P 500
benchmark. However, we argue that this value-added
should not be interpreted as “alpha” in the sense of proWINTER 2008

prietary investment acumen, but may be due to other
sources of risk premia that a 130/30 portfolio can exploit
more effectively than the long-only format.
Apart from these performance differences, Exhibit 1
shows that the remaining statistical properties of 130/30
index returns are virtually indistinguishable from those of
the S&P 500. In Exhibit 5, we report the correlations of
the 130/30 index with 0.25% one-way transaction costs,
0.75% annual short-sales costs, and 15%, 100%, and
unconstrained annual turnover to various market indexes,
key ﬁnancial assets, and hedge-fund indexes. For comparison, we report the same correlations for the S&P 500.
Not surprisingly, the 130/30 index is highly correlated
with all of the equity indexes, and the correlation coefﬁcients are nearly identical to those of the S&P 500. The
second two sub-panels of Exhibit 5 show the same patterns—the 130/30 index and the S&P 500 have almost
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EXHIBIT 3
Annual Geometrically Compounded Returns of the CS 130/30 Investable Index and S&P 500 Index,
January 1996 to September 2007

Note: Transaction costs (TC) are 0.25% one way, short-sales costs (SC) are 0.75% annually, and the annualized turnover constraint (T/O) is 15%.
Tracking error is relative to the S&P 500. The annual returns for 2007 are year-to-date returns.

identical correlations to stock, bond, currency, commodity,
and hedge-fund indexes.
Trading Statistics

To develop a sense for the implementation issues
surrounding the 130/30 index, Exhibits 6 and 7 report
the monthly and annual turnover and yearly averages of
the annualized tracking errors (obtained from the MSCI
Barra Aegis Portfolio Manager each month) of the 130/30
portfolio assuming 0.25% one-way transaction costs and
0.75% annual short-sales costs with annualized turnover
constrained to either 15% or 100%, or left unconstrained.9
The turnover of the 130/30 index ranges from a high of
16.2% in 2000 to a low of 6.2% in 2003, and is typically
24
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1% per month. For comparison, Exhibit 8 contains the
turnover of several S&P indexes.
In contrast to the 130/30 index which is intended
to be a dynamic basket of securities, the S&P indexes
are static, changing only occasionally as certain stocks
are included or excluded due to changes in their characteristics. Therefore, as a buy-and-hold index, the
turnover of the S&P 500 is typically much lower than
that of the 130/30 index. Exhibit 8 shows, however, that
even for the S&P 500, there are years when this static
portfolio exhibits turnover levels approaching the levels
of the 130/30 index, such as in 1998 when the turnover
in the S&P 500 index is 9.5%. Moreover, for other static
S&P indexes such as the Mid Cap 400, the turnover
levels exceed those of the 130/30 index. As a result, the
WINTER 2008
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EXHIBIT 4
Monthly Returns of the CS 130/30 Investable and Look-Ahead Indexes and S&P 500 Index (in Percent),
January 1996 to September 2007

Year

Jan

Feb

Mar

Apr

May

Jun

Jul Aug

Sep

Oct

Nov

Dec

Year

Jan

Feb

Mar

Apr

May

Jun

Jul

Aug

Sep

Oct

Nov

Dec

*NC = No Constraint
Note: The monthly returns of the CS 130/30 Investable Index are presented with and without transaction costs (TC) and short-sales costs (SC) under various
turnover constraints (T/O). The monthly returns of the CS 130/30 Look-Ahead Index are presented with no transaction costs, short-sales costs, or turnover
constraints. The annual returns for 2007 are year-to-date returns.

practical challenges of implementing the 130/30 index
are no greater than those posed by many other popular
buy-and-hold indexes.
Exhibit 9 contains the number of securities held on
the long and short sides of the 130/30 index with 0.25%
one-way transaction costs, 0.75% annual short-sales costs,
and with turnover constraints set at 15%, 100%, and
unconstrained. On average, the 130/30 index with 15%
turnover is long 270 names and short 150 names, yielding
a fairly well-diversified portfolio. In this respect, the
130/30 portfolio resembles a typical U.S. large-cap core
enhanced-index strategy for which the active weights are
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more variable over time and across stocks, thanks to the
loosening of the long-only constraint.
CONCLUSION

For a portfolio to be considered a true index, it must
be transparent, investable, and passive. Transparency
requires that the rules for constructing the index must be
systematic, clear, and easily implementable. Investability
requires that the components of the portfolio consist of
liquid exchange-traded instruments. Passivity requires that
the implementation of the index is purely mechanical,
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EXHIBIT 5
Correlations of the CS 130/30 Investable, Look-Ahead, and Long-Only Indexes to Various Market and
Hedge-Fund Indexes (in Psercent), January 1996 to September 2007

∗NC = No Constraint.

requiring little or no manual intervention and discretion.
With these criteria in mind, we have proposed a simple
dynamic portfolio as an index for the many 130/30 products that are now being offered.
Proposing a dynamic strategy as an index is a significant departure from tradition. However, the growing complexity of ﬁnancial products coupled with corresponding
26
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advances in trading technology and portfolio construction
tools provide compelling motivation for this next generation of benchmarks. Although the interpretation and
implementation of such dynamic portfolios will require
more effort than the standard buy-and-hold indexes, this
is the price of innovation as institutional investors become
more engaged in alternative investments. And as trading
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EXHIBIT 6
Monthly Turnover and Annualized Tracking Error for the CS 130/30 Investable Index (in Percent),
January 1996 to September 2007

*Annual turnover values for 1996 exclude the month of January.
Note: Results are based on calculations with 0.25% one-way transaction costs (TC), 0.75% annual short-sales costs (SC), and 15% and 100% annualized
turnover constraints (T/O).
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EXHIBIT 7
Monthly Turnover and Annualized Tracking Error for the CS 130/30 Investable Index (in Percent),
January 1996 to September 2007

*Annual turnover values for 1996 exclude the month of January.
†NC = No Constraint.
Note: Results are based on calculations with 0.25% one-way transaction costs (TC), 0.75% annual short-sales costs (SC), and no turnover constraint (T/O).

EXHIBIT 8
Turnover of Various S&P Indexes (in Percent)

technology becomes more sophisticated, we anticipate
the creation of many more benchmarks from dynamic
trading strategies, and we hope that the 130/30 index
will pave the way for that future.

APPENDIX
In this appendix, we provide additional details for constructing the 130/30 index. In subsection A.1 of the appendix,
we summarize the individual factors used in the ten Credit
Suisse composite alpha factors. In subsection A.2, we outline
a step-by-step procedure for using the MSCI Barra Optimizer
to construct the 130/30 investable portfolio, and in subsection
A.3, we provide summary statistics for the long-only version
of the 130/30 investable index.

A.1 Credit Suisse Alpha Factors
The inputs for each of the ten composite alpha factors
are described below. For more details, see Patel, Yao, and Carlson
[2007a].
Source: Credit Suisse Equity Derivatives Group.
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EXHIBIT 9
Number of Securities Held Long and Short Each Month in the CS 130/30 Investable Index,
January 1996 to September 2007

Note: Turnover constraint (T/O) is set at 15%, 100%, and unconstrained. *No Constraint (NC)

1. Traditional Value
• Price/12-Month Forward Earnings Consensus Estimate. Twelve-month forward earnings is calculated as
the time-weighted average of FY1 and FY2 (the
upcoming and the following ﬁscal year-end earnings
forecasts). The weight for FY1 is the ratio of the
number of days left in the year to the total number of
days in a year, and the weight for FY2 is one minus
the weight for FY1.
• Price/Trailing 12-Month Sales. Trailing sales is computed as the sum of the quarterly sales over the last
4 quarters.
• Price/Trailing 12-Month Cash Flows. The trailing cash
ﬂow is computed as the sum of the quarterly cash ﬂow
over the last 4 quarters.
• Dividend Yield. This is computed as the total DPS paid
over the last year, divided by the current price.
WINTER 2008

• Price/Book Value. For the book value we use the last
quarterly value.
2. Relative Value
•
•
•
•

Industry-Relative Price/Trailing 12-Month Sales
Industry-Relative Price/Trailing 12-Month Earnings
Industry-Relative Price/Trailing 12-Month Cash Flows
Industry-Relative Price/Trailing 12-Month Sales (Current
Spread vs. 5-Year Average)
• Industry-Relative Price/Trailing 12-Month Earnings (Current Spread vs. 5-Year Average)
• Industry-Relative Price/Trailing 12-Month Cash Flows
(Current Spread vs. 5-Year Average)
3. Historical Growth
• Number of Consecutive Quarters of Positive Changes in
Trailing 12-Month Cash Flows (counted over the last 24
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EXHIBIT A1
Summary Statistics for Monthly Returns of the CS 130/30 Investable Index (Long-only Version)
and S&P 500 Index, January 1996 to September 2007

∗A risk free rate of 5% is assumed. Note: The returns for the 130/30 index are based on calculations with 0.25% one-way transaction costs (TC) and 9%
annual turnover (T/O). The annualized mean returns are arithmetic averages of monthly returns multiplied by 12, not compounded geometric averages.

•

•

•

•
•

30

quarters). For each of the last 24 quarters we compute
the trailing 12-month cash ﬂow, and then count the
number of times the consecutive changes in those
trailing cash ﬂows are of the same sign from quarter
to quarter, starting with the most recent quarter and
going back. If the consecutive quarter-to-quarter
changes are negative, we count each change as –1, and
if they are positive we count each change as +1.
Number of Consecutive Quarters of Positive Change in
Trailing 12-Month Quarterly Earnings (counted over the last
24 quarters). We calculate the trailing 12-month quarterly earnings by summing up the quarterly earnings
for the last 4 quarters, and compute the number of consecutive quarters in the same way as in the item above.
12-Month Change in Quarterly Cash Flows. This is the
difference between the trailing 12-month cash ﬂow for
the most recent quarter and the trailing 12-month
cash ﬂow for the quarter exactly one year back from
the most recent quarter.
3-Year Average Annual Sales Growth. For each of the last
3 years we compute the 1-year percentage change in
sales, and then compute the 3-year average of those
1-year percentage changes.
3-Year Average Annual Earnings Growth. The same calculation as in the item above is done, but for earnings.
12-Quarter Trendline in Trailing 12-Month Earnings. For
each of the last 12 quarters we take the trailing 12month earnings and calculate the slope of the linear
trendline ﬁtted to those 12 points, and then divide
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that slope by the average 12-month trailing earnings
across all 12 quarters.
• 12-Quarter Trendline in Trailing 12-Month Cash Flows.
This is calculated in the same way as described in
the item above, but using cash flows instead of
earnings.
4. Expected Growth
• 5-Year Expected Earnings Growth (I/B/E/S Consensus)
• Expected Earnings Growth: Fiscal Year 2/Fiscal Year 1
(I/B/E/S)
5. Proﬁt Trends
• Number of Consecutive Quarters of Declines in (Receivables
+ Inventories)/Trailing 12-Month Sales (counted over the last
24 quarters). We start with the most recent quarter and
count back. If the consecutive quarter-to-quarter
changes are negative, we count each change as +1, and
if they are positive we count each change as –1. Receivables is calculated as the average of the receivables for
this quarter and the quarter one year ago, and the
inventories number is calculated similarly.
• Number of Consecutive Quarters of Positive Change in Trailing
12-Month Cash Flows/Trailing 12-Month Sales (counted
over the last 24 quarters). We start with the most recent
quarter and count back. If the consecutive quarter-toquarter changes are positive, we count each change as
+1, and if they are negative we count each change as –1.
• Consecutive Quarters of Declines in Trailing 12-Month
Overhead/Trailing 12-Month Sales (counted over the last
WINTER 2008
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24 quarters). We start with the most recent quarter and
count back. If the consecutive quarter-to-quarter
changes are negative, we count each change as +1,
and if they are positive we count each change as –1.
The trailing 12-month overhead equals trailing 12month sales minus trailing 12-month COGS minus
trailing 12-month EBEX, where the trailing 12-month
values are obtained by summing the quarterly values
for the last 4 quarters.
Industry-Relative Trailing 12-Month (Receivables + Inventories)/Trailing 12-Month Sales. The industry-relative
ratio is obtained by standardizing the underlying ratio
using the mean and standard deviation of that ratio
across all companies in that industry group.
Industry-Relative Trailing 12-Month Sales/Assets. The assets
value is the average of the assets for this quarter and the
assets for the quarter one year ago. The industry-relative
ratio is obtained by standardizing the underlying ratio
using the mean and standard deviation of that ratio across
all companies in that industry group.
Trailing 12-Month Overhead/Trailing 12-Month Sales.
Trailing 12-month overhead equals trailing 12-month
sales minus trailing 12-month COGS minus trailing
12-month EBEX, where the trailing 12-month values
are obtained by summing the quarterly values for the
last 4 quarters.
Trailing 12-Month Earnings/Trailing 12-Month Sales

6. Accelerating Sales
• 3-Month Momentum in Trailing 12-Month Sales. To compute this measurement, we first take the difference
between the current trailing 12-month sales and the
trailing 12-month sales one year ago, and then divide
that difference by the absolute value of the trailing 12month sales one year ago. We then take the difference
between this ratio today and this ratio 3 months ago.
• 6-Month Momentum in Trailing 12-Month Sales. This is
computed in the same way as described above.
• Change in Slope of 4-Quarter Trendline through Quarterly
Sales. To obtain this number we ﬁrst calculate the trailing
12-month sales for every quarter for the past 4 quarters,
and compute the average of those trailing 12-month
sales over the last 4 quarters. We then compute the
slope of the linear trendline through the trailing 12month quarterly sales, and divide it by the average quarterly sales. Finally, we compute the same ratio using
the data one year ago, and subtract that value from the
current ratio to obtain the change in slope.
7. Earnings Momentum
• 4-Week Change in 12-Month Forward Earnings Consensus
Estimate/Price. The 12-month forward earnings estimate
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is calculated as the time-weighted average of FY1 and
FY2 (the upcoming and the following fiscal year-end
earnings forecasts). The weight for FY1 is the ratio of the
number of days left in the year to the total number of
days in a year, and the weight for FY2 is 1 minus the
weight for FY1.
• 8-Week Change in 12-Month Forward Earnings Consensus Estimate/Price. This is calculated in the same
way as described above.
• Last Earnings Surprise/Current Price. The last earnings
surprise is the difference between the reported and
the expected earnings, both of which are reported by
I/B/E/S.
• Last Earnings Surprise/Standard Deviation of Quarterly Estimates for the Last Quarter (SUE). As reported by I/B/E/S.
8. Price Momentum
• Slope of 52-Week Trendline (calculated with 20-day lag)
• Percent Above 260-Day Low (calculated with 20-day lag)
• 4/52-Week Price Oscillator (calculated with 20-day lag).
This is computed as the ratio of the average weekly
price over the past 4 weeks to the average weekly price
over the past 52 weeks, minus 1.
• 39-Week Return (calculated with 20-day lag)
• 52-Week Volume Price Trend (calculated with 20-day lag).
This is computed in the standard way. Please refer to
Colby and Meyers [1988, p. 544].
9. Price Reversal
• 5-Day Industry-Relative Return. This is calculated as
the 5-day return minus the cap-weighted average
5-day return within that industry.
• 5-Day Money Flow/Volume. To obtain the numerator
of this ratio, for each of the past 5 days we compute
the closing price times the volume (shares traded) for
that day, multiply that by –1 if that day’s return is negative, and sum those daily values. To obtain the denominator, we simply sum the closing price times the daily
volume across the past 5 days (without multiplying
those daily products further by –1 if the corresponding
daily return is negative).
• 12–26 Day MACD—10-Day Signal Line. The MACD
and the Signal Line are computed in the standard way.
Please refer to Colby and Meyers [1988, p. 281].
• 14-Day RSI (Relative-Strength Index). This is computed
in the standard way. Please refer to Colby and Meyers
[1988, p. 433].
• 20-Day Lane’s Stochastic Indicator. Please refer to Colby
and Meyers [1988, p. 473].
• 4-Week Industry-Relative Return. This is calculated as
the 4-week return minus the cap-weighted average
4-week return within that industry.
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10.Small Size
•
•
•
•
•

Log of Market Capitalization
Log of Market Capitalization Cubed
Log of Stock Price
Log of Total Last Quarter Assets
Log of Trailing 12-Month Sales

A.2 MSCI Barra Optimization
The following procedure was used to construct the CS
130/30 Investable Index (where speciﬁc MSCI Barra keywords
are typeset in boldface):10

• Open the Barra Aegis System Portfolio Manager.
• On the drop-down menu, select Data → Select
Model and Dates. Select the ﬁle containing the data
for a particular date for which optimization is to be
run, and hit OK.
• On the drop-down menu, select Data → Benchmarks, Markets, and Composites, and hit the
button Remove All. Now hit the button Add File,
and go to the Barra data folder corresponding to your
date of interest to add the appropriate index
(SAP500.por). Press Process and then OK.
• On the drop-down menu, select Data → Import
User Data. First press Clear All. Then go to the ﬁle
containing the composite alpha-factor z-scores for the

EXHIBIT A2
Annual Geometrically Compounded Excess Returns of the CS 130/30 Investable Index (Long-only Version),
January 1996 to September 2007

Note: Excess return is defined as in excess of the S&P 500 Index. The returns for the 130/30 index are based on calculations with 0.25% one-way transaction costs (TC) and 9% annualized turnover (T/O). The corresponding gross annual excess returns are decomposed by overweight and underweight positions,
where overweights and underweights are defined with respect to the S&P 500. The tracking error relative to the S&P 500 is also included.
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S&P 500 companies on the date of interest. Highlight
the ﬁle and select Add. Press Process and then OK.
For the purposes of further directions, we assume that
the z-scores variable in the user input ﬁle is labeled
as “Value.”
• Now we construct the portfolio. On the drop-down
menu, select File → New Portfolio. Make sure the
date is correct and hit OK. On the drop-down menu,
select Portfolio → Settings. Within the Settings
window, select the following:

1.
2.
3.
4.
5.

6. Value = 0.0075
7. AS-CF Risk Aversion Ratio = 1.0000

Constraints Tab

General Tab
1. For the Benchmark ﬁeld, hit Select and choose the
index you just added (SAP500).
2. Set the Market field to Cash by pressing the Cash
button.
3. If you are not doing this process for the ﬁrst time in a
series, set the Initial Portfolio field to the previous
month’s optimized portfolio by pressing the Browse
button. Otherwise set the Initial Portfolio ﬁeld to a
portfolio containing $100 million in cash and no other
assets.
4. To populate the Universe field, hit the button Use
benchmark as universe.
5. Base Value option should be set to Net Value, which
is the default.

Tax Costs Tab
Everything in this tab should be disabled by default.

Optimize Tab
1. Under the Optimization Type heading, set the Portfolio option to Long-Short.
2. Under the Cash heading, leave the Cash Contribution at 0.00.
3. Under the Transactions heading, select Allow All.
4. Under the Leverage heading, enter the following parameters:
a.
b.
c.
d.

Max. Long Position = 130.00
Min. Long Position = 130.00
Min. Short Position = 30.00
Max. Short Position = 30.00

Risk Tab
Under the Return Distribution Parameters heading,
set:

WINTER 2008

Mean Return = Zero
Show Function Type = Probability Density
Number of Bins = 24
Probability Level (%) = 5
Leave the box Truncate Total Return at –100%
unchecked.
Under the Risk Aversion heading, set:

1.
2.
3.
4.

Constraint Priority = Default
Constraint Type = Beta
Constraints on = Net
Set the Factor ﬁeld to Beta and the corresponding Min
and Max fields both to 1, and leave the Soft box
unchecked.

Expected Returns Tab
Under the Expected Asset Returns heading, select
the following:
1. For the Return Source field, select User Data →
“Value”.
2. Leave the Description and Formula ﬁelds blank.
3. Set the Return Type to Excess for these directions
since we are dealing with z-scores (in general this setting
depends on the return type in your input ﬁle).
4. Set the Return Multiplier to 0.0100 (in general, this will
depend on the scale of the input z-scores), and do not
deﬁne anything for the Expected Factor Return.
Under the Return Refinement Parameters heading,
select the following:
5.
6.
7.
8.
9.

Risk Free = 0.00%
Benchmark Risk Premium = 0.00%
Expected Benchmark Surprise = 0.00%
Market Risk Premium = 0.00%
Expected Market Surprise = 0.00%

Transaction Costs Tab
1. Barra Market Impact Model = Off
2. Analysis Mode = One Way, and Holding Period
(years) = 1.00
3. Overall Transaction Costs (Buy Costs, Sell Costs,
and Short Sell Costs) should all be set to the desired
transaction cost level (0.00% for the unconstrainedTHE JOURNAL OF PORTFOLIO MANAGEMENT

33

IIJ-JPM-LO.qxp

1/28/08

8:36 PM

Page 34

turnover optimization and 0.25% for the constrainedturnover optimization) Plus 0.0000 Per Share.
4. Asset Specific Transaction Costs (Buy Costs, Sell
Costs, and Short Sell Costs) should all be set to
< none > Plus < none > Per Share.
5. Transaction Cost Multiplier is set to 1.0000 for the
unconstrained-turnover optimization, and to 0.7500 or
12.0000 for the constrained-turnover simulations. Oneway transaction costs of 0.25% and a transaction-cost
multiplier of 0.75 yields turnover of approximately 100%
per year, and when we increase the transaction-cost multiplier to 12, the annualized turnover drops to 15%.

Trading Tab
All of the General Constraints boxes should be left
unchecked, except for the Allow Crossovers box, which
should be checked. All of the Turnover boxes and all of the
Trade Limits boxes should be left unchecked.

Holdings Tab
Under the Asset Level Bounds, set:
1. Upper Bound % = < none >
2. Lower Bound % = < none >

Penalties Tab
Leave the default setting (blank).

Under the Grandfather Rule heading, leave everything
unchecked.
Under the General Holding Bounds heading, set:

Formulas Tab
Leave the default setting (blank).

Advanced Constraints Tab

3. Upper Bound % = b + 0.40
4. Lower Bound % = b – 0.40
Under the Conditional Rule heading, the Apply Conditional Rule box should be left unchecked.

Leave it disabled (default).

EXHIBIT A3
Monthly Returns, Turnover, Number of Securities, and Annualized Tracking Error for the CS 130/30 Investable
Index (Long-only Version), January 1996 to September 2007

∗Annual turnover values for 1996 exclude the month of January.
Note: The results for the 130/30 index are based on calculations with 0.25% one-way transaction costs (TC) and 9% annualized turnover (T/O).
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• At the bottom right of the Settings window press
the Apply button, then at the top right of the same
window press OK.
• From the drop-down menu, select Actions →
Optimize.
• Save the resulting output.

A.3 LONG-ONLY PORTFOLIO
CHARACTERISTICS
In this subsection, we report summary statistics for the
long-only version of the 130/30 investable index to provide
intuition for the contribution of the CS alpha factors to
overall performance. With the exception of the long-only
constraint, the parameters used to construct this portfolio are
identical to those used to construct the 130/30 investable
index with 15% turnover and 0.25% one-way transaction
costs.11 Exhibit A1 presents summary statistics for this longonly portfolio, Exhibit A2 contains its annual performance
and tracking error relative to the S&P 500, and Exhibit A3
provides its monthly returns, turnover, and other trading
statistics. Correlations between the long-only portfolio and
other indexes are given in Exhibit 5.

ENDNOTES
The views and opinions expressed in this article are those
of the authors only, and do not necessarily represent the views
and opinions of AlphaSimplex Group, Credit Suisse, MIT, any
of their affiliates and employees, or any of the individuals
acknowledged below. The authors make no representations or
warranty, either expressed or implied, as to the accuracy or completeness of the information contained in this article, nor are they
recommending that this article serve as the basis for any investment decision-this article is for information purposes only. This
research was supported by AlphaSimplex Group, LLC and Credit
Suisse. We thank Varun Dube, Michael Gorun, Jasmina Hasanhodzic, and Souheang Yao, for excellent research assistance, and
Jerry Chafkin, Arnout Eikeboom, Kal Ghayur, Balaji Gopalakrishnan, Ronan Heaney, James Martielli, Steve Platt, Phil Vasan,
and seminar participants at Credit Suisse and JP Morgan Asset
Management for many stimulating discussions and comments.
1
Examples of these types of anomalies include the size effect
(Banz [1981]), January effect (Rozeff and Kinney [1976] and Keim
[1983]), and book-to-market factor (Fama and French [1992]).
2
The ten composite factors are available for approximately
3,500 U.S. companies which span the combined universe of
the S&P 1500, the top 3,000 companies by market cap, the top
100 ADRs, and the Credit Suisse Analyst Coverage. Approximately 5,000 international companies are also covered.
3
Please see the appendix and Patel, Yao, and Carlson
WINTER 2008

[2007a, pp. 26–27] for further details on the constituents of
each composite factor.
4
The turnover of approximately 15% and 100% per year
is achieved by coupling the one-way transaction costs of 0.25%
with a transaction-cost multiplier of 12 and 0.75, respectively,
in the MSCI Barra Aegis Portfolio Manager. The unconstrainedturnover case is produced by setting transaction costs to zero.
5
This cost was deducted outside of the MSCI Barra portfolio optimizer in order not to affect the optimization algorithm.
6
Because the MSCI Barra Aegis Portfolio Manager calculates turnover as the one-way turnover versus the total absolute
value of the initial portfolio positions, we multiply turnover by
a factor of 2 and by the leverage ratio. The transaction cost,
TCostt, is set to zero for the ﬁrst month in the study (January
1996) and is assumed to be zero for all months for the lookahead index.
7
Note that the annualized tracking error of 1.83% is computed directly from the monthly excess returns (after fees) of
the 130/30 strategy, whereas the tracking errors in Exhibits 3,
6, 7, A2, and A3 are based on the monthly annualized trackingerror estimates produced by the MSCI Barra Aegis Portfolio
Manager.
8
Recall that the factors used in constructing the 130/30
portfolio are based on well-known accounting variables and
have been available to CS clients for several years.
9
The total, long-side, and short-side turnover in Exhibits
6, 7, and A3 are all computed as one-way turnover against the
total absolute value of the initial portfolio positions, whereas
in the MSCI Barra Aegis Portfolio Manager, the long-side
(short-side) turnover is computed against the value of the long
(short) positions of the initial portfolio. Also, each time a portfolio is constructed, the MSCI Barra Aegis Portfolio Manager
provides an annualized tracking-error forecast based on the
Barra multiple-factor risk model.
10
The look-ahead portfolio is constructed in the same
way, but instead of using the equal-weighted average of the
alpha-factor z-scores as the excess-return input in the optimizer, we use the one-month forward excess return (hence,
the look-ahead bias). The long-only version of the 130/30
index discussed in appendix subsection A.3 is constructed in the
same way as its 130/30 counterpart, but with the long- and
short-position leverage set at 100% and 0%, respectively.
11
Those same parameters now yield an annual turnover
of at most 9%.
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